

Tips for Formatting MLA Papers Using Microsoft Word
[bookmark: _GoBack]Formatting MLA papers using Microsoft Word can be challenging if you are not used to using the software. Luckily, Microsoft has several built-in shortcuts and tools that can help to simplify formatting your paper to MLA standards. Use the following tips to assist you in formatting your MLA paper.

Margins
MLA (8th edition) requires that papers have a one-inch margin on all sides of each page. To set your margins so that they adhere to MLA guidelines, use the following steps:

1. Press the “Ctrl” and “A” keys on your keyboard at the same time to select the entire paper (even if you do not have anything written yet, doing so will ensure that the margin settings apply to the entire paper, not just the first page).
2. Click on the “Page Layout” tab of the Word menu.
3. Click on the “Margins” dropdown menu button.
4. Select the “Normal” option showing one-inch margins on each side of the page.
[image: ]

Page Numbers
MLA requires that papers have page numbers in the upper right-hand corner of every page. To insert page numbers that will automatically carry over onto every new page of your document, use the following steps:

1. Click on the “Insert” tab of the Word menu.
2. Click on the “Page Number” dropdown menu button. 
3. Click on the “Top of Page” submenu.
4. Select the “Plain Number 3” option that shows the page number appearing on the right-hand side of the header.
[image: ]
5. Type your last name followed by a space before the page number. 
6. Press the “Ctrl” and “A” keys on your keyboard at the same time to select all text in the header and change the font to Times New Roman 12pt so that it matches the font of the rest of your paper (ALL text in your paper should be in Times New Roman 12pt).

Heading
Although writing a standard MLA heading seems simple enough, many have trouble remembering the correct order of the heading’s contents. Many also tend to place the heading incorrectly in the header of their paper. The heading should be placed at the top of the main page of the paper, starting on the first line, and should appear as follows:

[image: ]

The standard MLA heading should include your first and last name, your professor’s name, the class that the paper is being written for, and the paper’s due date. To remember this order, use the following mnemonic device:

No 		(“N” for name)
Professor 	(“P” for professor’s name)
Can 		(“C” for class name)
Dance		(“D” for date)

Some professors require that you include other information (e.g. the paper’s word count) in your heading. This information should be included on the line directly following the header (underneath the date). If your professor asks for something other than the standard MLA header, defer to your professor’s instructions.

Spacing

According to MLA, your entire paper should be double spaced. Use the following steps to double space your paper:

1. Press the “Ctrl” and “A” keys on your keyboard at the same time to select the entire paper (even if you don’t have anything written yet, doing so will ensure that the double spacing applies to the entire paper, not just the first line).
2. Click on the expand button ([image: ]) in lower right-hand corner of the “Paragraph” section of Word’s “Home” menu to open paragraph window (see image below for more detail).
[image: ]
3. Once in paragraph window, select “Double” from the “Line Spacing” drop-down menu.
4. Make sure that both the “Before” and “After” fields say “0 pt” to remove/prevent any extra spacing.
5. Check the box next to “Don’t add space between paragraphs of the same style.”
6. Before closing the paragraph window, make sure that it resembles the example below.
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Titles
All MLA papers should include an original title (i.e. not the title of the assignment, something that tells your reader what the paper will be about). After typing your heading, hit the “Enter” key on your keyboard once and then type out your paper’s title. Capitalize the first and last words of the title and all other words except for articles (a, an, and the), prepositions (in, of, to, for, etc.), and coordinating conjunctions or FANBOYS (for, and, nor, but, or, yet, and so) unless those exception words appear as the first or last word of the title or the first word in a subtitle following a colon. These capitalization rules also apply to the titles of outside sources (articles, books, etc.) on your Works Cited page.

According to MLA format guidelines, your title should also be centered. To center your title, use the following steps:

1. Select your entire title.
2. Click on the center button ([image: ]) in the “Paragraph” section of Word’s “Home” menu.

Use these steps and guidelines to format the title of your Works Cited page as well (be careful to use the words “Works Cited” for this page’s title, not “Bibliography,” “References,” etc.).

Paragraph Indents
According to MLA, all paragraphs should be indented one half (.5) of an inch. To set Word to automatically indent your paragraphs each time you hit the “enter” key on your keyboard, use the following steps:

1. If you are unable to see a ruler between the bottom of the Word menu and the top of your page, perform these steps before moving on to step two:
a. Click on the “View” tab of the Word menu.
b. Check the box beside the “Ruler” option of the “Show” section of the menu.


c. Now the ruler should be visible as shown below.

[image: ]

2. Now that you can see the ruler, you can add your indent. Hit the “Enter” key to move onto the line directly below your title (there should be no extra lines between your title and the first line of your paper’s first paragraph) and click on the left justify button 
([image: ]) to return your cursor to the left-side margin of your page.
3. Click and drag the top triangle on the ruler’s left-hand margin so that it sits on the line halfway between your left-hand margin and the “1” on the ruler. Your ruler should end up looking like the example below.

[image: ]

Now Word will automatically indent half an inch every time you hit the “Enter” key to move on to a new paragraph.  If you need to remove this automatic indent for any reason, all you have to do is place your cursor before the indent and press the “Backspace” key to delete it.

Block Quotations
MLA states that when a quotation is longer than three lines of typed text, it should be formatted as a block quote. Block quotes are set apart from the text of your paragraph and indented half an inch from the left-hand margin. To correctly format a block quote, use the following steps:

1. First, introduce your lengthy quote with a complete sentence and a colon (:).
2. Type out your quoted material without any quotation marks (the block format will take the place of quotation marks to show that the material is from another source). 
3. Be sure to include a citation following the quote. Unlike with shorter quotations, the period ending the quotation sentence will fall directly following the quote with the citation falling outside the sentence altogether.
4. Now, type another sentence addressing your quote (this step is important both for your paper’s effectiveness and for the formatting of your block quotation).
5. Place your cursor before the quote and press the “Enter” key as if you are starting a new paragraph.  
6. Place your cursor before the sentence following your quote and press the “Enter” key as if you are starting a new paragraph.  If you have automatic indents set, press the “Backspace” key once to remove the indent so that the remaining text of your paragraph after the quote will start at the margin, eliminating any confusion for your reader.
7. Select the entire quote and citation.
8. Press the “tab” key once to indent the entire quotation half an inch from the margin.
9. Your block quote should end up looking like the example on the next page. 

[image: ]

Try not to use too many block quotes in your paper. Your own words should make up the bulk of your paper’s text.

Hanging Indent
Each citation on your Works Cited page should be formatted with a hanging indent.  A hanging indent occurs when the first line of the citation begins on the left-hand margin and the second line of the citation is indented half an inch from that margin.  To format your Works Cited page using hanging indent, use the following steps:

1. Place your cursor at the very end of your paper and press the “Ctrl” and “Enter” keys at the same time to create a page break.
2. If Word automatically indents on the new page, press the “Backspace” key once to delete the indent.
3. Click on the center button ([image: ]) in the “Paragraph” section of Word’s “Home” menu.
4. Type “Works Cited” (without quotation marks) as your title.
5. Press the “Enter” key and click on the left justify button ([image: ]) to return your cursor to the left-side margin of your page.
6. Type out all of your Works Cited page citations, pressing the “Enter” key after each citation.
7. Select all of your citations, but do not select page’s title.
8. Press the “Ctrl” and “T” keys at the same time to format your hanging indent automatically.
9. Your citation(s) should end up looking like the example below.

[image: ]


The citations on your Works Cited page and your in-text citations should follow MLA guidelines. For more information regarding MLA citations, see the Pensacola State College Writing Lab’s MLA handout or reference the Purdue OWL MLA Formatting and Style Guide.  
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Spacing

According to MLA, your entire paper should be double spaced. Use the following steps to
double space your paper:

1. Press the “Ctr]” and “A” keys on your keyboard at the same time to select the entire
paper (even if you don’t have anything written yet, doing so will ensure that the double
spacing applies to the entire paper, not just the first line).

2. Click on the expand button () in lower right-hand corner of the “Paragraph” section of
Word’s “Home” menu.

3. Select the “2.0” option.

Titles





image6.png
EHS 0D+ Document2

ETR ove SR OSION  PAGCLYOVT  RGERNCES  MALNGS  RemW  viEw p———
% cue ¢ = #Find -~
ﬁgawy TmesNewRo w12 *| & & A2 = AaBbCCl AsBbCel AsBDC AcsbCel AQB assbeer daBsCel daBbCel dasbCel [ g ol
Gipboard 5 Font syies 5 eatng A
& f n % ) : ) 2 ) 3 ) i B s B . » ;
e - -
N {Indents and Spacing ' | Line and Page Breaks
Generat
Agnment: [ Left =
Outine levet: [BodyTert [=] L] Collapse by defaut
Edward Teach
Indentation
. Lot o Specit: o
i Professor Kidd — -
Right: 0] + (none) i 2
Mitorndents
Plunder 101
§ Spadng
Before: opt Line spacing: At
19 September 2015 atter opt Double 2 z

Don't add spage between paragraphs of the same style

Successful Plundering: The Blackl|

Preview

Tose | [sethspetmit o Gl

PAGELOF1 14woRDS (B % p——r
526PM

= el ol® e




image7.png
B HS 0D -

EER o | NSERT  DESGN  PAGELAYOUT  REFEReNCES

iy 2 TimesNewRo <12 <| A A Aa- e

e B I U O-¥

T Format Painter 4 - aex C¥- A
aipboard Font .

i B

i i

Tips for Formatting MLA Papers Using Microsoft Word 2013 docx - Word

MAILINGS

"=
=

Paragraph
2

RevEw VW
20T AaBbCdl AaBbCel AaBbC( AsgbCet AQB asebcer daBsCel AaBbCel tazbcel
= syes

?

3 i 4 i s i

2}
Your title should also be centered according to MLA format guidelines. To center your title, use

the following steps:
1.

Select your entire title.

2. Click on the center button () in the “Paragraph” section of Word’s “Home” menu.

Paragraph Indentions

Block Quotations

G A 7

= x
P— |
i Find -
25c Replace
It Select~





image8.png
EHS 00> Document2 - Word ? @ - x
PV o s ouon  pccieouT e wAtns e v P—
X cut - < #Find -

ﬁE@ . TimesNewRo-[12 -| A" & A2 AaBbCel | AaBbCL AaBbC( Aasbcct AQBI asebcer daBbcel daBbCel samscer |, e
Paste - 3 lormal lo Spac... ing ing itle: ubtitle ubtle Em... Emphasis  Intense E... N
e pumes BT U x TNormal | TNoSpac.. Headngl Heading?  Tile  Sublie  SubtieEm.. Emphasis Inense X st
Cipboara 15 Font siytes 5 eatng | A
o R g ' 2 f . B . =
Teach 1

E10F1 14

Edward Teach|
Professor Kidd
Plunder 101

19 September 2015

Successful Plundering: The Blackbeard Method





image9.png
@HS 00> Tips for Formatting MLA Papers Using Microsoft Word 2013.docx - Word ? @ -

Ul foME | INSIRT  DESGN  PAGELAYOUT  REFERENCES  MALINGS  REVEW  VIEW StudentDEV -
% cut . B s #Find -

i B2 Copy TimesNewRo -[12 -] A" &"[ A~ | % B aaBbCd AaBbCel AaBbCe Aasbcet AQBI nasbcer daBbCel daBbCel sampcel [ e

Paste - . - Loaly - = - lormal lo Spac. leading leading itle: ubtitle ubtle Em. mphasis  Intense N

e e e B U wexx AW A S0 | TNomsl TNoSpc. Hedingl Headng?  THe | Sublile Subtlefm. Emphasic Intensef [

apbos Font 5 Paragraph = syes 5 g A
i 2 f . s . » ; =

v
Accor(ﬁng 10 IVILA, all paragraphs should be mdented one hait (.5) Of an mch. 10 set Word 1o
automatically indent your paragraphs each time you hit the “enter” key on your keyboard, use the
following steps:

L i

1. If you are unable to see a ruler between the bottom of the Word menu and the top of your
page, perform these steps before moving on to step two:
a. Click on the “View” tab of the Word menu.
b. Check the box beside the “Ruler” option of the “Show” section of the menu.
B c. Now the ruler should be visible as she below.

paste B I U-moxx A-%-A- Hedng? T st SubteEn. 6

2. Now that you can see the ruler, you can add your indention. Hit the “Enter” key to move
onto the line below your title and click on the left justify button () to return your cursor to

N the left side margin of your page.
Block Quotations
R Hanging Indent

PAGE3OF3 916woRDs [ &





image10.png
EHS 0D0-> Document? - Word ? @3 - x
ETR vove  WSET DN PAGELAOUT | REERENCES  MALNGS  REBW VW P—_
X% cut . ] #Find -

ﬁﬁacam TmesNewRo w12 *| & & A2 AsBbCAl| AsBbCel AaBbCc Aasbcet AQB aasbcer daBocel daBbCel dambCel [ g0l
Pt a8 T Ut X Thomal | TNoSpac.. Hesdingl Heading?  Tde  Subitle SublleEm. Emphass IntenseEu | | qopo
Cipboara 5 Font siytes 5 eatng A
& f A ' 2 f . s . »
Teach 1

Edward Teach
1 Professor Kidd

Plunder 101

19 September 2015

E10F1 14

Successful Plundering: The Blackbeard Method





image11.png
Westinghouse and Tesla were giving him competition with the power plants that they were
installing and Edison was not happy about that. They bothwere installing different
infrastructure to power different arcas and many wondered whowould come outon top in the
end:
But instead of competing in the marketplace, Edison sought to destroy his competitor
through underhanded tactics—slandering Westinghouse’s technology in the press,
lobbying state legislatures to regulate alternating current out of existence and even killing
animalswithaltemating current to prove the technology unsafe for society. (Weingarten)
Edison was not afraid to kill animals, to get his pointacross to the public. He wanted themto

think that alternating current was dangerous. This did not work outin the end for Edison; he
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